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RESUMO 

A união de ideias inclusivas com as especificações cognitivas de indivíduos que 

possuem Síndrome de Down deve ser explorada nas escolas e motivou este estudo. Sua 

essência propõe o uso de uma ferramenta disponível na internet - programa Construct 2 

- como apoio didático para a implementação de ações capazes de propiciar a 

alfabetização científica de química a partir do ensino fundamental. O trabalho apresenta 

o protocolo utilizado para o desenvolvimento de um jogo da memória digital - 

MEMÓRIA ÁCIDA - idealizado para propiciar atividades inclusivas em uma turma de 

nono ano e o aprendizado da nomenclatura de ácidos, que por sua vez foram escolhidos 

utilizando as temáticas transversais sugeridas pelos PCN (saúde e meio ambiente). Os 

resultados sugerem que, apesar de ter sido inicialmente idealizado para se trabalhar com 

um público específico, todos os demais envolvidos podem ser beneficiados pelo uso 

desta ferramenta de caráter lúdico. 

Palavras-chave: Ensino de Ciências, Inclusão, Jogo digital. 
 

ABSTRACT 

The combination of inclusive ideas to cognitive specifications of individuals who have 

Down’s syndrome must be worked at schools and has motivated this study. The essence 

is the proposition of the use of a tool available on the internet-program Construct 2-as 

didactic support for the implementation of actions able to provide scientific 

alphabetization of chemistry from the elementary school. The work presents the 

protocol used for the development of a digital memory game-ACID MEMORY- 

designed to promote inclusive activities in a class of ninth grade and learning the 

nomenclature of acids, the choice was made based on themes suggested by PCN (health 

and environment). The results suggest that, although it was initially designed to work 

with a specific audience, everyone else involved can be benefited using this tool of 

playful character. 

Key words: Science education, Inclusion, Digital game. 



V Encontro Nacional de Ensino de Ciências da Saúde e do Ambiente 

Niterói/RJ, 2018 

Campus da Praia Vermelha/UFF  2 

 

INTRODUÇÃO 

O estudo de ciências, especificamente na educação básica, deveria ser 

prazeroso para aqueles que a vivenciam (TEIXEIRA & KUBO, 2008). São tantas 

abordagens possíveis encontradas na vida cotidiana do aluno; tantas alternativas dentro 

do conteúdo científico, que é difícil compreender o motivo pelo qual tantos sujeitos têm 

ojeriza por esse assunto. A pergunta que os educadores da área deveriam se fazer é: O 

que está acontecendo? Talvez uma profunda reflexão sobre os métodos pedagógicos, 

massivamente empregados por professores e escolas, seja necessária. Nessa perspectiva, 

torna-se imprescindível que docentes façam a seguinte reflexão: será que não existe uma 

forma melhor de aprender os conteúdos da formação escolar, de maneira que transcenda 

o modo tradicional, no qual o aluno acaba por decorar inúmeras regras, como por 

exemplo a nomenclatura de substâncias químicas? 

Introduzir a química no ensino fundamental deveria corroborar para tornar os 

alunos mais familiarizados e abertos ao aprendizado dessa ciência, uma vez que estarão 

desde a infância acostumados a determinados termos - específicos desta disciplina – 

como por exemplo, a nomenclatura dos ácidos. Não se deve subestimar a capacidade 

das crianças em aprender, já que são extremamente curiosas, pelo contrário, é 

importante aproveitar este período de extrema curiosidade para incentivar o carácter 

investigativo precocemente dos indivíduos (MEDEIROS et al., 2013). 

A discussão sobre a importância do aprendizado das Ciências na formação de 

um cidadão crítico, consciente do seu papel no mundo contemporâneo e capacitado para 

a tomada de decisões, não é uma temática nova. Contudo, essa reflexão deve ser 

estendida para os alunos com necessidades educacionais especiais (NEE) (TEIXEIRA 

& KUBO, 2008; BISHOP et al., 1999). Estes, também, precisam ter a oportunidade de 

compreender os fenômenos da natureza, assim como a relação existente entre o 

desenvolvimento das tecnologias e o crescimento da sociedade. E, para tanto, precisam 

ter uma formação teórica sobre as Ciências, ou seja, devem aprender, entre outras 

disciplinas, a Química. 

Incluir significa repensar a forma tradicional e conservadora de categorização 

das disciplinas. Baseando-se neste conceito, e seguindo os Parâmetros Curriculares 

Nacionais – PCNs; este estudo sugere que o ensino de Química pode e deve ser feito 

durante todo o ensino fundamental (BRASIL, 2007/ 2001/ 1996). 
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Há diversos tipos de alunos com NEE, cada um com um desenvolvimento 

cognitivo específico. Assim, pensar em inclusão escolar também implica em refletir 

sobre as teorias de aprendizagem e o professor deve ter um conhecimento sólido sobre 

as vertentes epistemológicas para que ocorra disseminação de argumentos favoráveis à 

inclusão escolar. A inclusão escolar já é uma realidade, e em algum momento de suas 

vidas profissionais, os professores terão como alunos, crianças com NEE. Aqueles 

educadores que tiveram a oportunidade de discutir sobre o tema durante a graduação, se 

sentirão mais preparados para ensinar (ORNELLAS, 2017; PUESCHEL, 2012; 

PACHECO & OLIVEIRA, 2011; FIGUEIREDO, 2001; STAINBACK & 

STAINBACK, 1999). 

As fundamentações teóricas utilizadas nesta pesquisa convergem seus 

argumentos em favor de ações inclusivas. Os pressupostos teóricos contidos no 

construtivismo individual de Piaget (1974) e na abordagem social de Vygotsky (1987) a 

respeito de como se dá a construção do conhecimento são confirmados pelos últimos 

estudos neurobiológicos, incluindo a plasticidade cerebral e o desenvolvimento 

cognitivo específico das crianças com Síndrome de Down (SD). Quanto mais precoce 

for a estimulação, maiores são as chances de que estes indivíduos consigam superar os 

desafios criados pela presença da deficiência mental em suas vidas (FILDER & 

NADEL, 2007; BISSOTO, 2005; BRIEN & BRIEN, 1999). 

No presente artigo propõe-se uma atividade capaz de promover processos 

inclusivos, e favorecer a aprendizagem sobre alguns ácidos – que possuem relevância 

no ensino de saúde e meio-ambiente - durante o estudo de Ciências Naturais, no contra 

turno de uma turma de nono ano do ensino médio, no contexto de um projeto de 

extensão universitário. Assim, os próprios colegas de turma confeccionaram um jogo de 

memória digital. O objetivo geral foi promover processos inclusivos reais, e em um 

segundo plano, trabalhar o ensino de ciências de uma turma de nono ano, que tinha 

entre seus discentes um indivíduo com síndrome de Down. Esta atividade foi idealizada 

para ser feita no computador, sendo definida, portanto, como um objeto virtual de 

aprendizagem (OVA). A tarefa culmina na apresentação de um jogo didático digital que 

relaciona a fórmula química do composto ácido com seu nome – um jogo da memória, 

nomeado como “MEMÓRIA ÁCIDA”, e sua ligação com conceitos de educação 

ambiental e da saúde. A proposta aplicada no 9° ano do ensino fundamental, pode ser 

estendida ao 1° ano do ensino médio.  
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METODOLOGIA 

A pesquisa bibliográfica no presente estudo se baseou em livros sobre inclusão 

escolar e sobre neurobiologia; artigos acadêmicos que tratavam de forma minuciosa a 

questão das particularidades do desenvolvimento cognitivo dos indivíduos com 

Síndrome de Down; incluindo monografias, teses e dissertações; a legislação 

educacional brasileira; entre outros documentos pertinentes à realização do estudo. A 

ferramenta de apoio didático proposta foi a criação de um jogo da memória digital, 

nomeado de “MEMÓRIA ÁCIDA”. O jogo digital foi confeccionado utilizando o 

programa chamado Construct 2, tendo como objetivo relacionar as nomenclaturas de 

seis ácidos com suas respectivas fórmulas químicas. 

O Construct 2 é uma ferramenta que não necessita codificação, pois todo 

processo é realizado de forma automática. O usuário apenas cria o enredo do jogo, o 

restante da aplicação é realizada praticamente por meio do mouse, com a ação de 

arrastar e soltar os objetos escolhidos no cenário principal (MEDEIROS et al., 2013). 

Muitos game makers – denominação dada a profissionais e a amadores que criam 

aplicativos e jogos digitais – utilizam a plataforma Construct 2 para a criação de seus 

trabalhos; logo, existe muita informação sobre esta linguagem de programação 

disponível em fóruns e vídeos do YouTube. 

Vale ressaltar que a empresa Scirra, que comercializa o Construct 2, 

disponibiliza o programa em três versões: Free Edition, que foi a utilizada para a 

realização deste trabalho; Personal License e Business License. Há também, no site, 

muitos elementos que auxiliam na construção de jogos digitais. 

RESULTADOS E DISCUSSÕES 

O desenvolvimento do trabalho foi baseado em pressupostos da inclusão 

escolar, com vistas a um ensino construtivista, e em estudos neurobiológicos, que 

englobam a plasticidade cerebral e o desenvolvimento cognitivo específico da SD. Faz-

se necessário salientar que as ferramentas propostas durante a construção desta pesquisa 

podem ser facilmente utilizadas por qualquer discente ou docente, independente se na 

classe existem alunos com NEE ou não. 

A dificuldade em se obter um protocolo que propicia um leigo a criar o jogo de 

memória digital, norteou o desenvolvimento do mesmo, e será apresentada em quatro 

etapas. Sendo elas: (1) Criação das cartas do jogo; (2) Criação das variáveis globais; (3) 

Criação da folha de evento; (4) Outras considerações. 
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1. Criação das cartas do jogo 

(i) Realizar o download da versão Free Edition no site: 

https://www.scirra.com/store/construct-2; (ii) Abrir o programa, iniciar um novo projeto 

e salvá-lo; (iii) No canto superior esquerdo clicar em: File → New → New empty 

project → Open; (iv) Na janela que se abre, clicar em: File → Save; (v) Escolher uma 

pasta de preferência para salvar o trabalho; (vi) Dar um duplo clique no layout para 

abrir a janela Insert New Object, clicar em Sprite, e escrever Card em Name when 

inserted; (vii) Clicar em Insert; (viii) Retornar para a janela Insert New Object e 

adicionar o mouse como outro objeto (a seta do mouse se transforma em uma cruz); (ix) 

Clicar em qualquer lugar do layout para abrir a janela Edit Image: Card (Default, Frame 

0). 

Na janela Edit Image: Card (Default, Frame 0), (i) clicar para adicionar a 

figura que representa a parte de trás das cartinhas do jogo; (ii) Fechar a janela Edit 

Image: Card (Default, Frame 0), a imagem escolhida fica disponível no layout; (iii) 

Selecionar a imagem, clicando em qualquer lugar em cima dela; (iv) No canto esquerdo, 

clicar em Instance variables. Na janela Card: Instance variables se abre. Clicar em + 

para adicionar duas variáveis para o objeto Card. 

A variável Card Face Frame indica qual carta o objeto (Card) representa; e a 

Face Up determina se a carta está virada com a face para frente ou para trás. Ao clicar 

em +, a janela New instance variable se abre. A variável Card Face Frame é do tipo 

numérica com valor inicial igual a zero. Já a variável Face Up, o tipo é boolean e o 

valor inicial é falsa. Fechar a janela Card: Instance variable. 

Dar um duplo clique na imagem. As janelas Edit Image: Card (Default, Frame 

0) e Animations se abrem. Nesta última, renomear Default, escrevendo Card Back. 

Desta forma, todas as cartinhas do jogo apresentam a mesma imagem na parte de trás. 

Na janela Edit Image: Card (Default, Frame 0), configurar as coordenadas x e y para 

zero. 

Na janela Animations, clicar com o botão direito do mouse → Add animation 

→ Renomear para Card Face. Na janela Animations frames, deletar o frame número 

zero. Clicar com o botão direito do mouse → Import frames → From files. Nesta etapa, 

as cartinhas são adicionadas ao programa. É importante adicionar cada par de uma vez 

para que o jogo funcione corretamente. Todas as imagens devem estar nas mesmas 

coordenadas x=0 e y=0. O procedimento é o mesmo utilizado para a imagem Card 
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Back. Ainda na janela Animations, com Card Face selecionado, no lado esquerdo da 

tela, alterar Speed para zero. Fechar a janela Edit Image: Card (Default, Frame 0). 

2. Criação das variáveis globais 

Para configurar alguns parâmetros importantes para o jogo, como definição das 

margens e tamanho das cartas, uma nova folha de evento deve ser criada. No lado 

direito da tela, clicar com o botão direito do mouse em Event sheet → Add event sheet. 

Renomeá-la para variáveis globais. 

Em variáveis globais, clicar em qualquer lugar com o botão direito do mouse 

→ Add global variable. Adicionar cada variável global com os respectivos valores 

iniciais. 

Na variável global gNumberColumns, tem-se o exemplo da variável global 

(gNumberColumns) que determina o número de colunas do jogo. Da mesma maneira, 

faz-se o ajuste das demais variáveis globais. 

3. Criação da folha de evento 

A folha de evento (event sheet) é a etapa responsável pelo funcionamento geral 

do jogo. Nela estão inseridas a linguagem de programação do Construct 2 para o 

funcionamento de um jogo da memória de 12 cartas. Para adicionar um evento novo, 

clicar em Add action. Para adicionar subeventos, subeventos em branco ou variáveis 

locais, selecionar o evento no qual o subevento está relacionado, clicar com o botão 

direito do mouse → Add → Add sub-event ou Add blank sub-event ou Add local 

variable. 

Evento 1: Novo evento. No evento 1, adicionar os parâmetros para inicializar 

as variáveis. Evento 2: Subevento do evento 1. O vetor das cartas é definido. Adicionar 

a variável local (Local number). Evento 3: Subevento do evento 1. Embaralha as cartas. 

Possui quatro variáveis locais. Evento 4: Subevento do evento 1. Cria o layout do jogo. 

Possui três variáveis locais. As cartas são postas na tela do computador. Evento 5: 

subevento do evento 4. Nesse evento, ao adicionar ação, buscar por Compare two 

values. Evento 6: Subevento em branco do evento 4. Evento 7 e subeventos 8, 9 e 10: 

Novo evento. O evento 7, assim como os subeventos 8, 9 e 10, estão relacionados com o 

funcionamento do mouse no jogo. Evento 11: Subevento do evento 10. Está relacionado 

com a pontuação. Uma combinação de cartas (Matches) equivale a 10 pontos (score). 

Evento 12 e 13: O 12 é subevento do evento 11, e o 13 é subevento do 12. Essas etapas 

são referentes a destruição do par de cartas quando a combinação é correta. Eventos 14, 
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15 e 16: O 14 é subevento do 10, o 15 é subevento do 14 e o 16 é subevento do 15. Essa 

etapa determina que caso não haja combinação entre as cartas, o jogo retorna para o 

início com as faces das cartas viradas para baixo. Evento 17: Subevento em branco do 

evento 10. Esta etapa indica que não há cartas selecionadas, ou seja, as etapas 

anteriores, a combinação ou não do par de cartas, já estão finalizadas. Evento 18: Novo 

evento. Nesse evento, os pontos e a quantidade de combinações ficam disponíveis no 

layout. Evento 19: Subevento do evento 18 Esse evento faz com que o jogo recomece 

quando todas as combinações das cartas são realizadas. 

4. Outras considerações 

O jogo está pronto! Para criar outros jogos da memória com outros enfoques e 

assuntos, é só substituir as cartinhas no CardFace, e salvar como. O jogo funciona na 

forma tradicional conhecida como jogo da memória, em que o jogador tem que 

encontrar duas cartas que combinem. Dentre as variações que foram elaboradas pelos 

alunos ressaltamos: (i) uma com a fórmula química do ácido e a outra com o respectivo 

nome; (ii) uma com a fórmula química e nome do ácido e a outra com sua 

contextualização na saúde; (iii) uma com a fórmula química e nome do ácido e a outra 

com sua contextualização ambiental. Quando as cartas formam um par, são destruídas e 

saem do layout do jogo. Ganha quem formar mais pares. 

É bom salientar que o jogo da memória proposto aqui não teve a finalidade de 

cobrir toda a nomenclatura dos ácidos, mas sim, propiciar uma ação inclusiva proativa, 

envolvendo toda a turma, além de exemplificar como este conteúdo e outros podem ser 

trabalhados de uma forma alternativa. Após a criação do jogo online, é muito fácil 

trocar as cartinhas para tratar dos mais diversos assuntos. Logo, os próprios discentes 

podem criar diferentes tipos de brincadeiras com seus colegas, tornando o processo de 

ensino aprendizagem muito mais prazeroso e estimulante. 

Cabe, ainda, alguns esclarecimentos sobre o motivo pela opção do jogo online 

ao invés do jogo físico. Isto está relacionado com o desenvolvimento cognitivo 

específico dos alunos com SD. Estes possuem um alto perfil de processamento da 

memória visuoespacial que facilita a aprendizagem por meio de imagens. Logo, um 

ensino mediado por ilustrações tem mais chances de obter êxito, quando comparado 

com uma educação exposta oralmente. Outra questão está relacionada com o 

estabelecimento de relacionamentos sociais entre os colegas de turma, sejam eles alunos 

com necessidades educacionais especiais ou não. Para desenvolver e aplicar o jogo, os 
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estudantes foram encaminhados para um laboratório de informática, onde trabalharam 

em equipe, aprendendo e interagindo um com o outro, auxiliando na criação, portanto, 

de um ambiente socioafetivo facilitador da construção dos saberes. 

CONCLUSÕES 

O trabalho apresenta o desenvolvimento de um material de apoio para ensinar 

determinado conteúdo da disciplina de química para alunos com SD, mas que envolveu 

os demais alunos. Esse estudo é um breve relato de experiência de como se pode 

trabalhar processos inclusivos, temas transversais e alguns conteúdos químicos, durante 

os anos de ensino fundamental. 

Toda a prática foi pensada para que os alunos NEE pudessem ter acesso as 

mesmas aulas e as mesmas atividades que os demais alunos. O princípio da igualdade 

educacional é premissa básica para a inclusão escolar. Logo, incluir um aluno com NEE 

no ensino regular é refletir sobre as metodologias didáticas. Estas devem oferecer as 

mesmas oportunidades para que todos possam construir o conhecimento. 

No caso da SD, aspectos específicos do desenvolvimento cognitivo desses 

sujeitos – um alto perfil de processamento da memória visuoespacial – foram 

importantes para a idealização do jogo da memória digital. O que refletiu na avaliação 

formal, não só do aluno com SD, mas de todos os demais. 

No mundo contemporâneo a tecnologia faz parte do cotidiano da grande 

maioria das pessoas, de modo que alunos de hoje têm facilidade para manusear 

equipamentos eletrônicos, como computadores e tablets. Logo, ensinar em um 

laboratório de informática pode ser uma estratégia facilitadora da aprendizagem, pois 

este é um espaço no qual os estudantes têm muita familiaridade. A versão paga do 

Construct 2 permite que os jogos possam ser disponibilizados no Android – sistema 

operacional do Google. Atualmente 30% dos alunos aqui citados estão trabalhando no 

desenvolvimento de aplicativos de celulares.  

Espera-se que esta pesquisa ainda dê muitos frutos relacionados ao processo 

educativo desses jovens. A finalização deste estudo não significa, contudo, que há 

soluções prontas, definitivas. Mais e mais dados devem ser considerados para a busca 

de novas alternativas pedagógicas. O importante é reconhecer nas crianças com SD, 

indivíduos capazes de aprender e crescer socialmente, tendo como fio condutor a 

educação. 
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